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Agenda

e NMS platform general description

e NMS architecture description

e Know the structure and contents of the NMS directories
e GUI description - main windows, buttons, and icons

e Learn how to start the NMS

e Understand the NMS Browser menus

e Know the difference between events and alarms

e Be familiar with the NMS Browser elements

e Understand the security levels

e Be familiar with the NMSDBTools utility

e Know how to create a back up of the database

e Understand the purpose and functionality of the NMS Streamer
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m' Network Management System (NMS)

¢ NMS monitors and controls communications in the network

e Enables viewing, modification and download of individual
configurations of hub elements and remote terminals

e Client/server architecture provides centralized management and control,
while giving access to multiple operators

e Advanced user interface used for

e Network configuration

Operation management

Monitoring and control

Alarm and event display

Statistics gathering
Windows based with full SNMP support

onfidential and proprietary information

SEIl NMS



Customer Educational Services

. -

Architecture

0SS / 3% party
applications

SNMP NMS Server

NMS SNMP
Agent

e
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The NMS is based on server/client architecture.

NMS Server application is remotely controlled from another computer running a Gilat coded browser
called NMS Browser.

The NMS Server computer is a 1U rack-mount Intel machine. It runs the NMS application and is LAN-
connected to all network elements (components) and the NMS browsers.
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ﬁ:\ Security

Internet

NMS server can only be accessed through the NMS browsers

The NMS browsers network is not accessible from the Internet

The only component that, if user allows it, can be reached through the

Internet, is the Remote Access Router

Make sure the antivirus definitions are up to date, on the management PC,
the NMS browser PCs and both NMS servers

(4}
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E NMS Main Directories

e All NMS application directories are located in the main NMS directory at:

e D:\NMS

e The NMS directory contains the following relevant sub-directories

e Backup

Bin
Configuration
Devices
Graphics
Help

License

Logs (optional)
MIB (optional)
Outputs
Repository
Temp
Topology

Confidential and proprietary information
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E NMS Main Directories

Backup

e The Backup folder is normally where backed up files are stored

e Since the location of the backup can be chosen at the DBTools, we
suggest to make sure backups are stored only in this folder, so anybody
can find them if needed

e Keeping a backup copy in another media, out of the hub is highly
recommended
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E NMS Main Directories

Bin

e The Bin directory contains all executable files, initial files and essential
operational files, such as

e NmsServer.exe ol
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Qe+ ) - T | Search [ Fokdrs | 4 . -

o NMSStreamer.exe e P — o0
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Fle 222

¢ NMSDBTools.exe e e
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byt b

o NMSStreamer.exe prieparins
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603KB  Apphcation ysjz

e NMS Watcher S et o
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e NMS.ini
e dll files

9

Confidential and proprietary information

SEIl NMS



Customer Educational Services

=
E NMS Main Directories

Configuration

e The Configuration directory is a legacy directory, which is not being used
in SkyEdge Il

@E)Topology
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E NMS Main Directories

Devices
e The Devices directory contains for each hub component the following

directories

e Configuration
e For each device its configuration file (xml) (under the \export sub-

directory)
B D:\NMS'\Devices\DPS\11\SW
e Software Bo &k vew Fas Dok te
e The software for each device (bin) S O d o o B
x
e Template

e The parameters xml format file, extracted

from each device’s “zip” package

& £ RESWITCH
B ) STANDBYHUBPROCESSOR
2 Graphics

DHep

£ License

1065 =~
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E NMS Main Directories

Graphics

e The Graphics directory contains all the graphic and icon files

& S My Network Places
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E NMS Main Directories

Help

e The Help directory contains the NMS full electronic documentation (CHM)

file

Confidential and proprietary information
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License

e The Licenses directory contains the software license file of the SkyEdge Il
system

e This license must be loaded in the NMS system, for the system and its
licensed features to be operative. This procedure can only be done
following Gilat Technical support directions
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E' NMS Main Directories

Logs

e The Logs directory includes the system log files
e These files include unique information about the system behavior,
and can be a good source for system troubleshooting
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MIB

e The MIB directory includes the system SNMP management information
base files (MIBs)
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Outputs

e The Outputs directory is a legacy directory which is not in use in SEIl

= O e
# () Backup
# () bin
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Repository

e The Repository directory contains all the packs (zip) files that holds for
each hub component and VSAT the following

e Element Software (bin)
e Parameters structure list with default values (xml)
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Topologies

e The Topology directory contains the hub topology and parameters export,
created from the NMS client

W os\opoloay =
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NMS Server Start Up
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M NMS Application Icons

e Four application icons can be seen at the taskbar (bottom right of
the screen)

NMS Server icon - The actual application that
controls the network

NMS Streamer icon - The application that ‘streams’
the software and some configuration parameters to
the VSATs

NMS MSSQL Server — Looks after the NMS Database,
configuration parameters, and software

e File Manager — Enables easy access browsing
through the NMS server from the NMS Browser
(Server Files function)

Confidential and proprietary information
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E Starting the NMS

NMS Server and NMS Browser Icons

¢ «q“

e On the NMS Server, at the “Start menu programs”, select NVIS > NMS
Servericon to start the NMS Server. The NMS Streamer and the file
manager should start shortly after it

&- NmsBrowser.exe
£ NMSDBTools.exe
M NmsSnmpAgent.exe
§% NmsServer.exe
S8 NMSStreamer.exe

e From a PC with access to the NMS, go to “Start menu programs”, and
select NMIS > NMS Browser

ﬂ NmsBrowser.exe

22
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"2
E Starting the NMS

Server Window

e You can view the NMS Server initiation process in the NMS Server Info
display. To open the NMS Server Info display, right-click the NMS Server
icon and select Show
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The NMS Server Info Display is used to monitor the NMS server boot-up process, components

s/w upload process.
This screen can provide technical information for troubleshooting procedures.
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E Starting the NMS

Software Licensing

e If you have purchased a new license and need to load a new Software
License file, reloading the license will activate the new license file. The
option to reload the license is found at NMS > Reload License. Reloading
Licenses can damage your configuration. Always consult a Gilat Technical
Support specialist before reloading a license file

e The License file is stored

at: D:\NMS\Licenses

24
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NMS Browser Graphic User Interface (GUI)
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E Starting the NMS

NMS Server Login window

e The NMS Server Login window is displayed
e Enter Username and Password

e At the Server name field, indicate the server name and IP address you
wish to connect to

Network Management System Login

26
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Normally the provided administrator's User Name is: gilat, Password is: gilat.
In the NMS Server Login window, type the Username and password; then select the NMS Server
name from the drop-down list and click OK.

SEIl NMS
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E Starting the NMS

The NMS Browser Opening Screen

Menu Bar [emes s o o o e o o
@ potiere G ptes BWH ) e ) o ) 08 v g) vSaTeView B Ertemal Mansgement H‘ (] e ) Db Bk S AsivSAT

Tool Bar
. e
4 @A s sERvER
Working | &= 2=
Modulator 1 ) NMS SNMPAgent Standby Hub Procestor
Area
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The NMS Browser is the graphic user interface (GUI) that acts as a client. The NMS Browser runs
on a different PC, connected via LAN to the NMS Server.

SEIl NMS
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E NMS Browser — Hub View

e The Hub View button @ HUBView OpPens the hub view window

I ¥4 HUB View

SE_II_Satellite_v6.1.0 MCR_101 NMSHUB NMS STREAMER
SE_Il_Application_v6.2.1
‘ .
= HSP_65
IPE = R e Components
@
' Ze NMS SERVER
"
= o
Modulator_1 DPS_11 NMS SNMPAgent Standby Hub Processor
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m NMS Browser — Hub View ‘fu“

Icons, Configuration Parameters, and Status View

e At the Hub View window, hub components are represented by icons
e The color represents the status of each component

e For a change made on a configuration parameter to take effect on the hub
component, parameters must be

e Saved
e Committed
e Component needs to be restarted (except the modulator and IPE)

e An asterisk (*) will appear next to the component’s name when a change in one
or more of its configuration parameters has been saved, but it has not been

committed
e An ‘at’ sign (@) will appear next to the component’s »‘7",
name when a change has been saved and committed, =
but the component has not been restarted et
g?“f/"
DPS_11(@)

The icons color code and meanings follows:

Blue — Unknown severity level.

Cyan — Disabled element.

Gray — Unmanaged.

Green - Normal trace events recorded by the network.

Yellow — Warning severity event.

Orange — Minor severity event.

Maroon — Major severity event.

Red - Critical severity event. The network might be non-operational.

Notes about parameters configuration:

Parameter changes that have been saved, can be undone by not saving and closing the configuration
window, or by clicking on the “Undo” button.

Parameter changes that have been saved and committed cannot be undone. At this point parameters
are already loaded into the relevant component. The option appearing as “Undo committed changes”
(right click Configuration menu) is not currently implemented and therefore we do not advise to use it.
Parameter changes that have been saved, committed, and then the component rebooted, cannot be ¢
undone.

Components are grouped hierarchically. Linked elements can be committed on one action by right clicking
on the component, and selecting Configuration > Commit Changes (Include linked elements.
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E NMS Browser — Hub View

Linked Elements

e The lines that link the elements represent the parent-child relation
between the components. This relates to the way the components are
grouped in the context of the NMS

e This is only a logical connection that groups elements together, and does
not relate to the parameters in each element

¥4 HUB View

=
@ NMS STREAMER >
NMSHUB A SE_Il_Application_v6.2.1
D o
Resources ,
Components
-ﬂc NMS SERVER
==
NMS SNMPAgent Network Segment 1

Linked Element

30
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M NMS Browser — Hub View

Linked Elements — Parameters

e Some parameters exist in several components (e.g. TimeZone). The value
of these parameters, under standard conditions, should be the same
across all components where the parameter exists

e At the NMS we call these parameters, Linked Parameters, and such
elements are indicated by the icon next to the parameter |2

e When a linked parameter is modified in one of the components, we will
need to commit the parameter in the component, and in all its related
components —

L
SE_ll_Satellite_v6.1.0

PE

e To unlink such a parameter, right click the LINK icon and choose unlink
from o
e |
the menu Ll

Confidentialand proprietary information
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Some parameters are linked through various elements, in this way, when modifying one of
these parameters, the change is reflected in the other components that also use that
parameter, keeping the consistency of the database.

These parameters link can also be broken if wished, just right clicking on the link icon and
selecting to Unlink parameter, as shown above.

SEIl NMS
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E' Telemetry and Statistics

e The Telemetry tool enables the system operator to monitor the activity, the
configuration and performance of network elements.

e There are two types of telemetry/statistics:
e Single ‘9| - Polls the selected network element once
e Multiple Q I- Polis the selected network element at fixed intervals

e Statistics will be generated at an interval set by the operator. In order to set
the polling interval, right-click Multiple Q| icon and select Set Interval

v Set Interval

Confidential and proprietary information
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E NMS GUI - Menu Bar

e The Menu Bar has the following menus

Administration Menu
Fault Management
Services Menu

View Menu

Tools Menu

Wizards Menu
Window Menu

Help Menu

| Advestaton ok Marsgsnert Servces Vew ook Wiowds  indow teb |
@ oo G poties awl LN evens () aim () e view {g) vsasview i EensMansgemert “ () severries ) DusboneBackio. 0 AdsVSAT
P sotmseverions |~ Tenpises | 9 Hiﬂ ofodgenent e | Lo gl S ) BooManape
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M NMS GUI - Menu Bar ——

Administration Menu

e The Administration menu contains the following options

_éc_i‘ministration

User Adminstration...

Partitions
Server >
Database 4

Licenses Report
Reload Licenses

Profiles

Exit

Login — Open the NMS Login window and allows logging into as a different user or logging into a
different NMS Server.

User Administration - Opens the User Administration window.

Partitions - Opens the Partition management window.

Server - Displays a sub-menu that enables you to change the Server Properties and manage the
Server files.

Database — Enables access to the backup function.

Licenses Report — Displays the license report.

Reload Licenses — Opens the Reload licenses function. This option should only be used while
following directions from Gilat Technical personnel.

Profiles - Opens the Profiles editor window.

Exit - Closes the NMS Browser.

SEII NMS
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N
M Security Features

User Management

e A security feature controls which users have access to various network
functions and components
e NMS operations have priority levels

e A user is only allowed to access operations/configuration
windows/statistics that have a priority level equal to or lower than his/her
access level

e The user access level is assigned by the network administrator

The NMS user access control mechanism restricts the access of various customers sharing a Hub
to their own network components and defines different levels of access according to the
authorization profile of the user.

SEII NMS

35



Customer Educational Services
@&

\‘\ i
& NMS GUI - Menu Bar - ;_-:-.a“

User Administration - Access Levels

e There are six categories of user access that can be assigned to the NMS
users
e The lowest level (View) is the default and is assigned to all users

e Each level includes all of the levels beneath it

User Level Description

Tech Support This user level is an unique user, with rights to change the critical

(Highest) parameters.

Supervisor The user can fully configure the network

Admin The user can configure the network and define Log record filters, but cannot
work with User Partitions.

Operator The user can execute network commands.

User The user can view and monitor network telemetry and statistics

Guest (lowest) | The user can view the network configuration.

“onfidentialand proprietary information
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E NMS GUI - Menu Bar

User Administration

e From the Administration menu, select the User Administration
| administration |
® Logn

Guest  User Operator Admin  Super. TechSup.

Yes Yes Yes Yes Yes Yes

37
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In the System-Wide Password mode, if choosing advanced, the password given must follow the
following rules:

1.The password length should be between 8 to 20 characters.

2.The password must include at least one uppercase character.

3.The password must include at least one lowercase character.

4.The password must include at least one Numeric character.

5.The password must include at least one non Alpha-Numeric character.

6.The password should not resemble to the user ID or username.

To edit a user, double click the user or choose a user from the user administration window and

click the Edit User tab.
To create a new user, click the New button at the upper right corner of the user administration

window .
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Fault Management Menu

e The Fault Management menu contains the following options

| Fault Management

Alarms

Events

Events Display Filtration
Events Archive
Event Log File Properties

>onfidential and proprietary information 38

Alarms - View a textual information log (date, time, type, etc.) concerning all alarms.

Events - View a textual information log (date, time, type, etc.) concerning all system events and
alarms.

Events Display Filtration — Gives access to Filtration wizard, to create, modify, delete Event
filters.

Events Archive — Opens a tool to retrieve events upon a variety of criteria such as Date, Event
ID, Severity and other.

SEIl NMS

38



Customer Educational Services

")
E Fault Management

@ |
Event and Alarm i
e Any change in the status of a network element is shown to the operator in

a graphic color-coded event that contains textual information about the

status change
e The same information is also saved in a Log file for later retrieval
e The Log file can be found at — D:\NMS\Log\NMS_yymmadd.log or at the

path defined in the NMS.ini file

39
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Fault Management »,TLM“

Alarm Status Display

e The Alarms icon (%) &ams opens the Alarms window

e The Alarms window displays the current alarm detail for a time period by:
Severity, Alarm ID, Status, Date, Time, Alarm Name, Element Name,
Element Type, Element ID, and Description

e To save the list click on the Save button, and a Saving Format option
window will be displayed

#% System-wide Alarms

All Alarms | HUB Alarms | VSAT Alarms

Severity |Alarm ID | Status |Date | Time | Alarm Name |

35 Open  04Jul06  12:05:10 HeakCheck HSP_65 HSP 6s Ping Failed: Request timed ¢
Warning 34 Open 04 Jul06 12:05:14 235009 Outbound Outbound Cisco Switch_1 changed its
33 Clear 04 Jul 06 12:05:1S STREAMER_Eve NMS Streamer NMSStreamer Firmware version-05.04.07.
32 Open 04 Jul 06 12:04:50 Database used Datasbase NMS Disk Monitoring is Unavailab
31 Open 30 Mar 06 12:34:00 System Clock System Clock NMS NMS NMS System Clock Was Accr
30 Clear 30 Mar 06 12:27:35 Backup General NMS Database NMS Backup File Deleted from Temporary
29 Open  29Mar06 18:17:24 Element Status DPS_1 oPS 1 Request timed out
28 Open  29Mar06 18:17:24 HealtCheck OPS_1 oPs 1 Ping Failed: Request timed ¢
27 Open  29Mar06 18:17:24 Element Status SIU_B B SIU_A Request timed out
26 Clear  29Mar 06 18:17:24 Element Status MGW_ MGW 1025 Stop i
2s Open 29 Mar 06 18:17:24 Element Status  SNMP NMSSNMPAgent SNMP Age Request timed out 1
24 Open 29 Mar 06 18:17:24 Element Status  MODULATOR_MO Modulator MOD 1 Request timed out
23 Open 29 Mar 06 18:17:24 Element Status  Cisco Cisco Cisco 1 Request timed out
22 Open  29Mar 06 18:17:24 Element Status  VPP_1 VPP 1 Request timed out <
e > l
| Details i
|

Alarm Code: Ii Parent Name: '7 Subsystem 1D r— User 1D: [—'

40
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Alarms are generated by events and are tagged to the component that is identified by the event.
Alarms are color-coded to indicate severity.

Alarms are color-coded as follows:

Blue — Unknown severity level.

Cyan — Disabled element.

Gray — Unmanaged.

Green - Normal trace events recorded by the network.

Yellow — Warning severity event.

Orange — Minor severity event.

Maroon — Major severity event.

Red - Critical severity event. The network might be non-operational.

The user can view only VSAT Alarms or only HUB Components Alarms by choosing VSAT Alarms
or HUB Alarms tabs
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Alarm Status Display (1)

e To save the list of alarms with their current state, click on the Save button,
and a file format option window will be displayed

#% System-wide Alarms

Fault Management Alarms

All Alarms | HUB Alarms

Severity |AlarmID |Status |[Date  |Time |
Open 04 Jul06 12:05:10

Open  DaWINA 1210514
al open :05:15

Of :04:50
Cl  History 127:35
Open 29Mar06 18:17:24
Open 29Mar06 18:17:24
Open 29Mar06 18:17:24
Clear 29Mar06 18:17:24
Open 29Mar06 18:17:24

29Mar 06  18:17:24

29Mar 06  18:17:24

29Mar 06 18:17:24

#% Save All Alarms to File

IRRYIBB88LREERA

N8

]
Details

Alarm Code: [/ Parent Name: Subsystem ID: I“ User ID:

Confidential and proprietary information

When right clicking an alarm, an Alarms management window will open. Each alarm has three
states:

Open — When an alarm is created it is automatically in the open state.

Acknowledge — After registering the alarm, the hub operator can change its status to
acknowledge. The alarm will continue to be displayed in the Alarms window.

Clear - An alarm is cleared either by an event that indicates that the problem no longer exists, or
by an operator that feels that the problem that caused the alarm no longer exists. The cleared
alarm will continue to be displayed in the Alarms window.

When the problem indicated by the alarm has been solved, the hub operator can remove the alarm
from the display by clicking the remove option. Once an alarm is removed from one Alarms
window, it is automatically removed from all Alarms windows on all NMS clients.

Once an alarm is opened it remains open until it is both cleared and acknowledged. An alarm is
acknowledged by an operator taking action to indicate that the alarm has been seen.

Remove - removes the alarm from the Alarm window.

History — will show all the history alarms of the specific component of the chosen alarm.
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e The Events button & Events in the Tool bar opens the Fault Management

Events window

ID number, Date, Time, Event Name, Element Name, Element Type, Element

ID, and Description

+8 System-wide Events

Fault Management Events | -
FheredIN zmﬂ Fidered OUT Everts

Severity | Eventi | Date
[Normol —e66275 07 Jn07
6278 07307
sz 073007
6276 073007
666275 073n07 Fae
666274 07 Jan 07 quest (MacNotFound). MAC: 00-10-48-9%
666273 07 Jan 07 est (MacNotFound). MAC: 00-00-60-9
sz 073007 5t (MachotFound). MAC: 00-10-48-%
666271 07 Jan 07 -

666270 07 Jan 07
66265 073n07
o268 073007
267 073m07
266 073007
265 07207
666264 07 Jan 07
263 073007

quest (MecotFound). MAC: 00-11-25-0/
BootP Unknown Bootp Bootp 1 1 Unknown request (MacNotFound). MAC: 00-11-25-0 ¥ |
>

Parent Name: | Subsystem ID: | User 1D: |

Confidential and proprietary information

e The Events window contains a list of all events in the system over time. The

following information is provided for each event: Severity, Sequential event

42

The Event Log information is sequential and includes the source identification and description of
the event. The events are color-coded:

Green — Normal trace events recorded by the network.
Blue — Unknown severity level.

Cyan — Disabled element.

Gray — Unmanaged element.

Yellow — Warning severity event.

Orange — Minor severity event.

Maroon — Major severity event.

Red - Critical severity event.

The events shown in the system wide events window can be saved, filtered, sorted and paused for
the convenience of the user.
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E' Fault Management

Event Log Display (Cont.)

e The filter option allows the activation of a filter to a more convenient view as
well as to manage only the relevant events. To allow that, filters must be initially
created through the Event Display Filtration Wizard

e The Save button, allows to export the events present in a variety of formats
(XML, XLS, HTML. Clipboard, etc.)

.S vxtem wid

Faul Management Ev

|Time  |EventName |Element Name |Element Type Element ID |MPN |
108:27:07 BootP Unknown Bootp Bootp RO 1

M Save Events to File

666263 07 Jan 07 08:23:06  BootP Unknown Bootp Bootp 1 1 Uﬁmmw@.m:wn-mv'l
S 2|

Eov“:l:oﬁ:[— Parent Name: r— Slbﬂ)ﬂ-ll):l I.Imll):'
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Events Archive

e The Event Archive enables the user to search for events that were
removed from the Event window and are stored in the NMS Events
Archive database

*% Events Archive

Confidential and proprietary information
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View Menu

e The View menu allows
e Quick access to most common functions (list)
e Displaying/hiding toolbars

HUB View

Templates

Software Versions
Parameters Groups
Software Groups
YSATs View

HUB Management
External Management
Windows

Testing alarms

Toolbars 4

Hub View - Open the Network View window to configure, monitor and control the hub and network
components.

Templates - Open the Template Configuration window to configure new parameter templates and
modify existing templates.

Software Versions - Opens the Software Repository window.

Parameters Groups - Opens the Parameters Group Configuration window.

Software Groups - Open the Software Groups window.

VSATSs View - Open the VSAT Manager window.

HUB Management — Opens the Hub Elements Manager window.

Windows — Opens the Active Windows window.

Toolbars — Enables/Disables the following Toolbars: Services, Management, Administration, and

System.

SEII NMS
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Tools Menu

e The Tools menu contains the following options

[ Tooks -

Change Software Group Monitoring

#% VSATs IP configuration

VSAT: IP configuafion

VSATs AAA Monitoring VSATID / | VSAT Name |Mask Network address | Broadcast
3301 thirty-theee oh-one 1.101.11.255 1.101.11.49 255.25.2%5
3303 3303 0.0.00 0.0.0.0 255.255.25
3304 0.0.0.0 0.0.0.0 255.255.25
MCh ’ 5000 Beacon 0.0.00 0.0.0.0 255.255.%5
vi 255.255.255.0 10.51.3.0 10.51.3.2%
2 255.255.255.0 10.51.4.0 10.51.4.29
V3 255.255.255.0 10.51.5.0 10.51.5.28
V4 255.255.255.0 10.51.6.0 10.51.6.25
v 255.255.255.0 10.51.7.0 10.51.7.28
V6 255.255.255.0 10.51.8.0 10.51.8.28
4 255.255.255.0 10.51.9.0 10.51.9.29
8 255.255.255.0 10.51.10.0 10.51.10.2
Ve 255.255.255.0 10.51.11.0 10.51.11.2
255.255.255.0 10.51.12.0 10.51.12.2
<
Found: 0
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VSATS Ips — Displays a report on current VSATs and their IP Configuration within the satellite
network (Network and Broadcast address, and whether they are DHCP or NAT servers).
Change Software Group Monitoring — Enables monitoring of the queue of VSATSs that were
selected using the Change Software Wizard.

VSATs AAA Monitoring — a report of Online VSATs which did not send an AAA massage in the
last 7 days.

Search - Opens the Find VSAT window. VSATS can be searched by several criteria such as
VSAT ID, MAC Address, Software version, Name, Status, and other.
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Wizards Menu

e The Wizards menu contains the following options
e Add VSAT - Add VSAT wizard
e Change SWG - Change Software Group wizard

e Compare - Compare Definitions and Values wizard

| Wizards |

Change SWG
Compare

47
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Menu Bar

e The Windows menu option lists all currently open windows and allows
quick access to them

#% Windows List
Active Windows

View

3 HUB View

=3 VSAT Templates Configuration
=3 VSAT Software Groups

=3 VSAT Parameters Groups
; f VSAT Configuration (2206)

Confidential and proprietary information
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4
Help Menu
e The Help menu contains the following options
e Contents - NMS User Manual Help file
e About — displays the NMS Version information
82 SkyEdge 11 NMS V16.0 =01 x|

Help o o« 2 &

Hde Bock Fowad Pt

Contents... Contrts | g | Someh]

i \ SkyEdge] |

NETWORK
MANAGEMENT
SYSTEM

NMS Browser Version «__
NMS Server Version

Version 16.1.0.21

Server: Local [Gilat SkyEdge Iff version 16.1.0.21

onfidential and proprietary information
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NMS VSAT Configuration Building Blocks
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E’ NMS Browser — Hub View

Licenses, Authentication and Commissioning

e After VSAT is installed and configured, it runs the power-on sequence for
VSAT authentication on the NMS

e When the process is completed successfully, the VSAT is set in

Commissioned state and the date of the Commissioning is displayed in the

VSAT Configuration window

fate Commissioned
B 12/2/2008 12:19:12 PM

Confidential and proprietary information

After the VSAT authentication process has been completed, the VSAT MAC Mode parameter
cannot be modified. Issuing the Release license command allows modifying the VSAT MAC Mode
parameter and changing the VSAT authentication mechanism.

To release the VSAT license and modify VSAT authentication mechanism:
Open the VSAT Manager window.

Browse to the relevant VSAT.

Right-click the VSAT and select Release license.

A progress window will be displayed

SEIl NMS
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E NMS Browser — VSAT Manager

o The VSATs View icon {glvstsven opens the VSAT manager window

e The number of total configured VSATs, Connected VSATs, Committed VSATs
and Commissioned VSATs is indicated in the bottom-right corner of the
window

1: YSATs Yiew

VSATs View

[OD-[o]s B+ D[S /@acdS
B System Name [iD | Status | ProductNa... | Software Ve... | Parameters ... | Software Gr... |
2205  Critical SkyEdgell.. 60.01.00.16  WG_256 SW_513
2206 2206 Critical SkyEdgell.. 60.01.0016  WG_256 SW_513
2207(@) 2207 Critical SkyEdgell.. 60010016  WG_256 SW_513
/—' \
(Totd: 3 VSATs, 0 connected, 3 committed, 2 commissioned [System: 3 VSATs, 0 connected 4
S —
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Connected VSATS: Indicates the number of VSAT that are currently online and ready to service.
Committed VSATSs: Indicates the number of VSATSs that have been saved and committed.

Commissioned VSATSs: Indicates the number of VSATSs that have been authenticated and
authorized.

SEIl NMS
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onf

tic

Description

Status

Blue and green

Connected

Blue and red

Disconnected/Offline

Blue and gray with red question
mark

Status Unknown

VSAT on green background with
amber lock mark

VSAT in the IP Restricted
mode

VSAT on green background with
black lock mark

VSAT in the IP Blocked mode

VSAT on red background with
black lock mark

VSAT in the RF Blocked mode

ddddr s

VSAT on green background with
red lock mark

Unauthenticated

and proprietary information
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General Description

e Before configuring a VSAT on the NMS, several parameters must be pre-
configured

e VSAT Software Repository — This is a list of all available VSAT
software versions

e Templates — A set of Templates must be applied to each VSAT module

e Software Group — A Software Group address must be applied to each
VSAT software version

e Parameters Group Address — An address that is associated with a
specific RSP must be applied to each VSAT

54
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VSAT Software Repository

e To configure the VSAT Software version, click the Software
Repository button @ Sotbere Vertions

[& O
Software Name Bin File Software Version | Remote Processors Add Ons
1 |SW_60.01.00.16  Repository\VSAT|60.01.00.16\SW\YSAT,00_60.01.00.16_Bin.bin 60.01.00.16 Access_06.01.01.01
Data_06.01.00.20
2 |sw_60.02.01.08 [SelectPackedFile... (R o WRR 60.02.01.08 | Access_06.02.01.00 VSAT.01_01.00.01.08_Bin.bin
Data_06.02.00.08 V/SAT.08_06.02.00.00_Bin.bin
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The VSAT Software Repository window contains VSAT software versions and the software
components supported by the version (RPs — Remote Processors): Access and Data.
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Templates

e To configure the VSAT Templates, click the Templates button — Terpiss

1: YSAT Templates Configuration

VSAT Templates Configuration

VSAT Software VSAT RPs
SW_BODH]NS Am_mm.mm Template 8-Co ;;;_Temp[a?e_
SW._60.02.01.08 Data_06.01.00.20

56
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The VSAT Templates Configuration window contains Template configuration, associated with the
VSAT Software version and component type.

Only one Template of each type (Access, Data) can be specified per VSAT. The template type
applicable to a VSAT is defined by the VSAT type (IP, Call, etc.).
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.
Software Groups

e To configure the VSAT Software Groups, click the VSAT
Software Group button = | saitwere Gioups

1: VSAT Software Groups

VSAT Software Groups ” OQKEY e
Name Software Version Software Group Address | OB ID |StreanAdd—Ons ]StreamID [StrearmgMode I I
60.01.00.16 513 1 [ 0 Continuous

4
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The VSAT Software Groups window contains the Software Group Address associated with every
Software version. Every VSAT is configured with the Software Group Address associated with its
software version. The NMS Streamer transmits software versions according to the Software Group

Addresses.
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VSAT Configuration Building Blocks . .a#!
Parameters Groups

e To configure the VSAT Parameters Groups, click the VSAT Parameters

Groups button S samios o

1: ¥SAT Parameters Groups

VSAT Parameters Groups

Name Group Address  |OBID | Stream ID| Streamer PID | treaming Temph |ResetBt | |
256 1 0 0

Template 8-Copy of Access_Tem v [l

Confidential and proprietary information
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The VSAT Parameters Groups window contains Access templates associated with each Parameters
Group. This address is used by the NMS Streamer to send Access Template parameters.
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e —

Templates - g!

¢ In the SkyEdge Il network, templates are used to configure VSATs

o Template parameters are configured in the specific Templates Parameters
window, and then are assigned to the VSATs

e The following templates are used for VSAT configuration
e Access

e Data

1: YSAT Templates Configuration
VSAT Templates Configuration

Template_

Sw_60.02.01.08 Data_06.01.00.20
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e The Template button | Iewises in the toolbar opens the Templates’
Parameters window

:: ¥SAT Templates Configuration
VSAT Templates Configuration

Access_06.01.01.01

Sw_60.01.00.16 |
Data_06.01.00.20

Sw_60.02.01.08

60
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e To add a new template, select the VSAT Software, VSAT RPs and click the
Add button ©
e To display the Template Function menu, right-click the template.

e To open the Template configuration window, double-click the relevant
template or right-click the template and select Configuration

s: ¥SAT Templates Configuration
VSAT Templates Configuration

VSAT Software VSAT RPs
SW_60.01,00.16 Access_06.01.01.01
SW_60.0201.08 Data_06.01.00.20

W Commit

#) Unds

Export Template
Import Template

61
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To duplicate a template, right click the template and choose duplicate. If you wish to duplicate a
template to other VSAT software, right click the template and chose Duplicate to Software.
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NMS Streamer

62

SEIl NMS

62



Customer Educational Services

N
m NMS Streamer

e Just as the NMS is used to manage the software versions and Access
templates running on the Hub components, it also manages the software
versions and access Template of the VSATs

pr |

e The NMS Streamer is a module of the NMS Server which constantly
broadcasts the current Software versions and Access Templates that
correspond to the different VSAT groups

soﬂware and Access temp], te

Gl W)
v

NMS - Streamer
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VSAT Software Group Address

ame

e The VSAT Software Group Address is used by the NMS Streamer to

continuously transmit the VSAT software version

e Every VSAT downloads the software version that is associated with its

Software Group address

NMS
Streamer

Software Version 1

VSAT (Software Address 520)

(Software Address 520) Software Version 2
(Software Address 530)

. (- | . Software Version 3
e — (Software Address 540)

onfidential and proprietary informatios

Software Address number range: 512 to 767

S -y
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VSAT Parameters Group Address

e The VSAT Parameters Group Address is used by the NMS Streamer to
continuously transmit the VSAT Access (RSP) template

NMS
Access Parameters Streamer

(Parameter Group Address 260)
VSAT pr—

(Parameter Group Address 260) Access Parameters :f\' Q

(Parameter Group Address 270)
. i @ | ° .

I L Access Parameters
(Parameter Group Address 280)

Sonfidentialand proprietary information
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E NMS Streamer

e The NMS S/W Streamer can be accessed from the NMS Server screen *

e Details on its status, and what is being streamed to the VSATs can be
monitored from the NMS Browser, by right clicking at the NMS Streamer

icon and selecting Telemetry > Streamer Status

]
4]

St

5

e

Streamer Status

NMS STI
© Fauks

Events

£ Events Archive

) dams

Confidential and proprietary information

200 60.01.00.16

Streamer Telemetry

reames Telemety

w62 1

CPrnd  IPFwd

VSAT.00_60.01.00.16 BIN.bin 1

2%

513 Stieaning = Al

o [Hame | Oubound D | Poromelers ougs | Vevion | ose | Sze o pametess | Seon D | |
A

1090557... Yes 56

SueamD  [Typo  [IPAdders |

[Put___ [MinBandwdth | MaxBandwdth |
64000 256000

NMS Streamer related events, can also be viewed by right clicking on the NMS Streamer icon

and selecting Events

#% Element Events

Event ID |Date |Time |EventName

Element Name

Element Type

Element ID

_{ol =

Description

FOETE 1S Mar  15:33:0
FOE7S 1S Mar | 15:33:0
Fon72 15 Mar | 15:33:0
TFOETL 15Mar 151330
Foe70 1S Mar | 15:33:0
FOEED 1S Mar | 15:33:0
71130 14 Mar | 16:37:2

STREAMER._Eve
STREAMER._Eve
STREAMER._Eve
STREAMER. _Eve
STREAMER _Eve
STREAMER. _Eve
STREAMER._Eve

MMS Streamer
MMS Streamer
MMS Streamer
MMS Streamer
MMS Strearmer
MMS Streamer
MMS Streamer

MMSSErearmner
MMSSkrearmer
MMSSkrearmner
MM3Skreamer
MMSSkrearner
MMSSkrearmer
MMSSkrearmer

2

1

IPE-521 TCF Tunnel Conneckion-Connected!
Gzl

821

IPE-821 TCP Tunnel Connection-Disconnected!

3
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M NMS Redundancy

Architecture

e Both NMS Servers
must be constantly on

e Configuration and
Repository databases
are backed up and
restored automatically
between the Main and
Backup NMS servers.

Database synchronization process:

@

4
- 19 19 R
> 17,16,23 |O
S S
Main NMS Backup NMS

Switch

Port 28 Closed

Browser Browser

XX

Browser
68

The Main NMS Server awakens every ten minutes to check port (20/28). If the port is open, it
checks when was the last time the database was restored on the Backup NMS Server. If
synchronization is due, it initiates one at the proper time.

The Backup NMS Server awakens every ten minutes to check port (20/28). When it finds port 28
closed, it turns back to sleep mode. When notification from operating system regarding a file

copied to the FTP directory is received, the Backup NMS Server initiates database restore. Only
local browser can connect to the Backup NMS Server machine.
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Operations

e To initiate an NMS redundancy application: Start-> NMS->
Redundancy.exe
e From the Redundancy application the operator can do the followings:
e Check the Server status
e Check the database synchronization status
e Initiate manual database synchronization

Initiate server switchover

Synchronization scheduling

Suspend/Resume synchronization process

§
g
B
g
g
(‘7‘;
g

69
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Switchover

Verify the NMS database Backup and Restore instances match
Check NMS Server Status

Under Tasks tab click , Click Yes on the confirmation dialog box

Check NMS Server Status after the switch over process had finished

B Dotabase Synchronization =10l x|
Statumes | Tasks | Configuraton |
Senc status Server A172.19.11.1) Server 8 [172.19.11.2)
NMS Dasbase Machie Info Machee info
Backup. 1273172009 42123 PM Role [Backue Role [
L [mzmenizard ServesNome  [FMS SERVERT Serves Nome  [NMS SERVERZ
SysemTeme [12731/2009427 2PM SytemTie [12731/200942705PM
Beouton Databace Daabace; Dotabace:
Last Modiied [12/3172009 35301 PM NMS DB [ONUINE NMS DB JONUNE
Backup. [n7zosa0e06Pm Reposiory 08 |V — Reposiary 08 | I —
Restore 12/3172009 4 04 06 PM Services Services
NensSecver eve. Roers Nm:Servec exe. [Faes
NMSBooP | NMSBooP [Fawws
Last Refiesh Time
1273172009 4 27.05PM FosMansgemert  [Rirewg FoaMansgement  [Rirmrg
F?m‘m Aophation Stated
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This slide summarize the NMS Switchover procedure, for a complete information about the NMS
Redundancy application functionality please refer to Gilat Official documentation.
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NMS Backup and Restore
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E’ Database Backup

e The SkyEdge Il NMS database can be backed-up automatically
e Binary backup (*.NBK2) can be performed while the server is running
e NMS Database can be backed-up in the following ways

e Automatic scheduled backups

e Manual on-line backup from NMS Browser

e Manual on-line backup from NMS DBTools

#% Automatic Database Backup
Database Backup (NMS DB)

rE— | avetades 17216 11 25|
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N
E' Schedule And On-Line Backup

e The Database Backup icon Wossetis on the NMS Browser
tool bar menu opens the Automatic Database Backup window

3: Automatic Database Backup

Database Backup (NMS DB) 4 % On-Line
e Backup

Schedule
Backup

02:05 02:05 02:05 02:05 [ 02:05 02:05 02:05
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To configure Automatic scheduled backup, enter only minutes at the chosen day and hour. For
example, if you wish to schedule a backup at 02:05 every day, enter only 05 at appropriate place,
and save your configuration.

To do an immediate backup, press the Backup Now Button.

Every Backup can be saved in 2 locations: Primary directory and secondary directory. If one of
the configured directories is not available, the Alternate directory will be used. When configuring
an FTP username, Password and IP address, the Backup file will be copied to the FTP server as
well as to the primary and secondary directories.
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o3
NMS DBTools Utility Functions @

e The NMS DBTools utility enables you to perform the following operations
Backup NMS database files
Restore NMS database files

Build and upgrade NMS database structures
Delete the NMS database contents

e When performing the NMS backup, it is not necessary to close the NMS
Server and NMS Browser. When performing all other operations using the
DBTools, the NMS Server and NMS Browser must be closed

74
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=
H NMS DBTools Utility

e To activate the NMSDBTools utility, click Start and select
NMS-NMSDBTools.exe

g |
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=
& NMS DBTools Utility (ctd.)

e The main NMS DBTools window, gives access to all its functions

e Common DB Functions

e Backup v =loix
]

[ Restore DBTools Actions
Action Selection

€ Upgiade Database Backup

B |

Perform the Backup action to save
the entire NMS database to a backup

e
Itis recommended to backup the
database on regular basis, especially
before making major changes.

This action does not require the NMS
Server to be shut down
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The other DB functions are reserved to Gilat technical support personnel.
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")
M Test Your Knowledge

1.

8.

Confidential and proprie

In what path are the event-logs located?

Why may we sometimes need the Events filtration function?

What are the templates that are used in VSAT configuration?

What is the DBTools utility used for?

Under what path is the software for the system elements located?

Where can you backup the NMS files from?

What is the difference between Admin user and Supervisor User in the NMS
user administration?

What are the three types of Status Alarm can have?
77
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Thank You
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